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Introduction

Dell™ ChangeBASE is a leading provider of automated application compatibility analysis, remediation and 
conversion.

ChangeBASE can assess and fix application compatibility issues automatically prior to migration to the latest 
Microsoft platforms and virtualized package environments. ChangeBASE also enables you to virtualize your 
packages automatically. 

ChangeBASE  is based on a thin client-server model in which most of the processing is carried out by a central 
service. Compatibility assessment checks against the selected migration platforms are carried out 
automatically by default, whenever packages are imported into a ChangeBASE database.

ChangeBASE version 6.1 introduces the ability to create links to external data source. This allows you to expand 
your application assessment to include information on how the applications are being used within the 
environment.  Once the link has been created, it will be maintained and refreshed to ensure that the most up-
to-date data is used within custom checks and for reports. Tapping into external data gives you insights to help 
plan for migration projects.

The guide is intended for network administrators, consultants, analysts, and any other IT professionals who are 
responsible for setting up ChangeBASE. 

This chapter covers the following topics:

Key Phases of a Migration Project

Assessment Capabilities

Features and Benefits

Key Phases of a Migration Project
 l Identify: The first step is to identify both the managed and unmanaged packages across the enterprise. 

Dell™ Asset Manager can be used to perform this step. 

 l Plan/Rationalize: Once the packages have been identified, the best practice is to rationalize packages 
that have similar functionality and/or have multiple versions. This approach means that only the latest 
versions of software are being submitted to the migration project. Once the number of packages has 
been defined, the amount of project resources can also be planned.

 l Import and Assess: The list of packages collated during the rationalization phase should be imported 
into ChangeBASE in order to test compatibility with the target platform(s). The packages are 
automatically assessed against the relevant checks. Once the compatibility results are visible, packages 
can undergo another round of rationalization to ensure that effort is only spent on packages that will 
work on the target platform(s). Incompatible packages should be upgraded, redeveloped or retired. 
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 l Fix: ChangeBASE assesses packages according to a Red/Amber/Green (RAG) system. ChangeBASE can 
automatically remediate many Amber issues, and some Red issues, by means of MST (Transform) files. 
The underlying packages and installations are never modified directly. ChangeBASE can also fix 
compatibility issues through the use of additional files such as Manifests and runtimes to allow packages 
to run correctly on the new Platform. By using Transform files, subsequent upgrades or patches can still 
be applied while allowing you to maintain support for the particular packages.

 l Virtualize: ChangeBASE can automatically create a virtualized package in a number of formats, 
including Microsoft’s App-V, Symantec Workspace Virtualization (SWV), and VMware’s ThinApp.

 l UAT: The fixed package is now ready for User Acceptance Testing (UAT). Package owners can test in the 
target environment.

 l Deploy: The package and fixes are deployed to the target environment.

 l Manage: There is a 'Patch Assessment' report that rolls up Microsoft Patch Tuesday updates from July 
2013 onwards. When you run the report, it shows the packages in your database on which the 
updates are likely to have an impact. The current RAG statuses of your applications remain 
unaffected by the report. 

Assessment Capabilities
ChangeBASE provides automated application compatibility testing and fixing for the following: 

 l Windows XP, 32-bit and 64-bit

 l Windows 7, 32-bit and 64-bit

 l Windows 8, 32-bit and 64-bit

 l Windows Server 2003 32-bit and 64-bit (including R2) 

 l Windows Server 2008 32-bit and 64-bit (including R2)

 l Windows Server 2012

 l Microsoft Office 2007, 2010 and 2013 dependencies

 l MSI Installer Integrity - ICEs (Internal Consistency Evaluators) checking and fixing 

 l Microsoft App-V, Microsoft Server App-V, VMware ThinApp, Citrix XenApp and Symantec SWV

NOTE: Browser Compatibility also allows the automated testing of Web applications for compatibility 
with Internet Explorer 8, 9 and 10, and Firefox. Refer to Web Capture.

Features and Benefits
 l True Client/Server Model

 l Multi-threaded imports across all the CPU resources in parallel, allowing the import and 
simultaneous assessment of high volumes of packages.
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 l Import from all shared resources across a network, with simultaneous viewing of the 
assessment results.

 l Instant Multi-Platform Compatibility Assessment

 l Identify compatibility issues instantly on import into ChangeBASE, across a wide range of 
specified target platforms. So, for example, you can simultaneously see the issues that would be 
affected by deploying packages on both Windows Server 2012 and Windows 8.1, and arrive at 
accurate and informed decisions on the timeframes and costs of such deployments, in order to 
prioritize packages for relicensing, replacement and testing.

 l Repackage non-standard or legacy packages prior to import so that you can test your entire 
inventory of packages for compatibility issues.

 l Auto-Fix Compatibility Issues

 l Resolve application compatibility issues prior to deployment with minimal manual effort, to avoid 
repeated assessment cycles and to substantially accelerate package delivery. Reduce post-
migration support issues.

 l Virtual Compatibility Assessment

 l Determine which packages you can virtualize within seconds, and track middleware 
dependencies, saving days of testing time.

 l Package Virtualization

 l Automatically virtualize your packages. Save time, avoid errors and meet demand more quickly 
than with manual conversions.

 l Auto-Fix  for Virtual Platforms

 l Evaluate packages for compatibility issues with virtual target platforms, and fix them in just a 
few simple steps.

 l Automate Corporate Packaging Standards

 l Test for issues related to in-house and packaging (MSI) standards and apply automated fixes to 
ensure compliance. Develop and customize QA checks and related remedies in order to achieve 
significant time and cost savings compared to manual checking.

 l Ongoing Management

 l Introduce changes quickly, easily and reliably, with the highest degree of confidence.

 l Reduce security risks and deployment times by the periodic running of an assessment report 
that shows the likely impact of past and present Microsoft updates  on your package estate.
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Before You Start...

ChangeBASE System Requirements
Before installing ChangeBASE, ensure that your system meets the minimum hardware and software 
requirements described in the following sections.

Local Database Setup

Minimum  Requirements

Remote Database Setup

Minimum Client Requirements

Minimum Requirements for Server Hosting ChangeBASE Service

Minimum Requirements for Server Hosting SQL Database

Minimum Requirements to Host on a Virtual Environment

Virtual Machines

Virtual Machines used for Repackaging (EXE/BAT/VBS/CMD)

Virtual Machines used for Virtualization

Recommended Configuration for Optimal Performance

Local Database Setup
For a training course, a POC (Proof Of Concept) installation, or where there is only to be one user of 
ChangeBASE, it is usual for all components (including the ChangeBASE service) to be installed on the same 
machine, which should be running under one of the following Operating Systems:

 l Windows Vista SP2 (x86 and x64)

 l Windows 7 SP1 (x86 and x64)

 l Windows 8 (x86 and x64)

 l Windows 8.1 (x86 and x64)

 l Windows Server 2008 R2 SP1 (x64)

 l Windows Server 2008 SP2 (x86 and x64)

 l Windows Server 2012 (x64)

 l Windows Server 2012 R2 (x64)

ChangeBASE 6.2.3
Prerequisites and Getting Started Guide

7



Minimum  Requirements
Provided that the machine is going to be importing less than 1,000 packages, it should meet the following 
minimum specifications:

Table 1: Minimum Machine Requirements for Local Database Setup

Display 
Resolution

Core Processor RAM (GB) SQL Server .NET 
Framework

Network 
Connection

1024 x 768 pixel 
array

Quad-core 
processor

8, preferably 
on a 64-bit 
Operating 
System

SQL Server 
Express 
2008/2012

4.5 Gigabit 
Ethernet

CAUTION: The SQL Server Collation must be Case Insensitive (CI).

You will also need the following:

 l Microsoft Visual C++ Redistributable 2012. It is available from http://www.microsoft.com/en-
us/download/details.aspx?id=30679. Install the 64-bit version on 64-bit Windows, and the 32-bit version 
on 32-bit Windows. 

 l A Hypervisor for ‘Legacy Conversion’ (hereafter typically referred to as ‘Repackaging’) and/or 
Virtualization. See Virtual Machines.

 l If you are going to be using the ChangeBASE API, you will need PowerShell 3.0. It is automatically 
installed with Windows 8 and Windows Server 2012. Alternatively, you can download it from 
http://www.microsoft.com/en-gb/download/details.aspx?id=34595 or http://www.microsoft.com/en-
us/download/details.aspx?id=34595.

Remote Database Setup
In the event that more than one user connects to the same database, the ChangeBASE client software may be 
installed on each of the workstations ('clients'), with the ChangeBASE service and database(s) hosted remotely.
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Figure 1: Multi-User Setup

Minimum Client Requirements
Each client should be running under one of the following Operating Systems:

 l Windows Vista SP2 (x86 and x64)

 l Windows 7 SP1 (x86 and x64)

 l Windows 8 (x86 and x64)

 l Windows 8.1 (x86 and x64)

 l Windows Server 2008 R2 SP1 (x64)

 l Windows Server 2008 SP2 (x86 and x64)

 l Windows Server 2012 (x64)

 l Windows Server 2012 R2 (x64)

Each client should meet the following minimum specifications:

Table 2: Minimum Client Requirements for Remote Database Setup

Display 
Resolution

Core 
Processor

RAM (GB) .NET 
Framework

Network 
Connection

1024 x 768 Quad-core 8 (16 if a large number of 4.5 Gigabit 
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Display 
Resolution

Core 
Processor

RAM (GB) .NET 
Framework

Network 
Connection

pixel array processor packages are  imported), 
preferably on a 64-bit 
Operating System

Ethernet

You will also need the following:

 l Microsoft Visual C++ Redistributable 2012. It is available from http://www.microsoft.com/en-
us/download/details.aspx?id=30679. Install the 64-bit version on 64-bit Windows, and the 32-bit version 
on 32-bit Windows.

 l A Hypervisor for ‘Legacy Conversion’ (hereafter typically referred to as ‘Repackaging’) and/or 
Virtualization. See Virtual Machines. 

 l If you are going to be using the ChangeBASE API, you will need PowerShell 3.0. It is automatically 
installed with Windows 8 and Windows Server 2012. Alternatively, you can download it from 
http://www.microsoft.com/en-gb/download/details.aspx?id=34595 or http://www.microsoft.com/en-
us/download/details.aspx?id=34595.

Internet Connectivity Recommended

It is highly recommended that an internet connection is available when using ChangeBASE, as the access to 
software and assessment group updates, and the associated online help, are dependent on this.

If internet connectivity is not possible, please contact Dell to discuss alternative delivery methods.

Minimum Requirements for Server Hosting ChangeBASE 
Service
These requirements are dependent on the numbers of packages being imported for assessment, and on the 
numbers of clients, and are to be taken as recommendations rather than absolute minimums.

Table 3: Minimum  Requirements for Server Hosting ChangeBASE Service

  Small Operation (i.e. 
less than 1,000 
packages and less than 
10 clients)

Medium Operation (i.e. 
between 1,000 and 
5,000 packages and 10 
or more  clients)

Large Operation (i.e. 
more than 5,000 
packages and 10 or 
more  clients)

Operating System One of:

 l Windows 7 SP1

 l Windows 8 

 l Windows 8.1

NOTE: A 64-bit 
Operating System 
is recommended 
wherever 

Windows Server 2008 R2 
SP1, Windows Server 2008 
SP2, Windows Server 
2012, or Windows Server 
2012 R2.

Windows Server 2008 R2 
SP1, Windows Server 2008 
SP2, Windows Server 
2012, or Windows Server 
2012 R2.
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  Small Operation (i.e. 
less than 1,000 
packages and less than 
10 clients)

Medium Operation (i.e. 
between 1,000 and 
5,000 packages and 10 
or more  clients)

Large Operation (i.e. 
more than 5,000 
packages and 10 or 
more  clients)

possible, 
especially if you 
are using 64-bit 
SQL Server.

Core Processor Quad-core processor 8-core processor 16-core processor

RAM (GB) 8 16 32

.NET Framework 4.5 4.5 4.5

Network Connection Gigabit Ethernet Gigabit Ethernet Gigabit Ethernet

You will also need:

 l Microsoft Visual C++ Redistributable 2012. It is available from http://www.microsoft.com/en-
us/download/details.aspx?id=30679. Install the 64-bit version on 64-bit Windows, and the 32-bit version 
on 32-bit Windows.

Minimum Requirements for Server Hosting SQL Database
ChangeBASE supports both SQL Server 2008 R2 and  SQL Server 2012. The requirements are as given in the 
following links:

 l SQL Server 2008 - http://msdn.microsoft.com/en-us/library/ms143506(v=sql.105).aspx

 l SQL Server 2012 - http://msdn.microsoft.com/en-us/library/ms143506.aspx

NOTE:  The server may run SQL Server Express, but due to its one GB of RAM usage restrictions, as well 
as its database size limits, it is recommended that SQL Express is used for no more than 600 packages.

CAUTION: The SQL Server Collation must be Case Insensitive (CI).

It is recommended that:

 l The SQL Server Browser service is set to Automatic.

 l TCP/IP protocol is enabled in the database(s).

Minimum Requirements to Host on a Virtual Environment
Hosting on a virtual environment is supported. The minimum requirements remain the same, but with the 
following additional requirements for medium and large operations

 l The number of recommended cores should not be shared with other virtual computers

 l The amount of available RAM should not be shared with other virtual computers

 l On the SQL Server, the ChangeBASE database and SQL TempDB should be located on physically separate 
drives and not shared with other virtual computers
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Virtual Machines
Virtual machines (VMs) are utilized by ChangeBASE for the Repackaging of legacy installer files (whether in EXE, 
VBS, BAT or CMD format) into MSIs, and for the conversion of MSIs/EXEs into virtual formats (Virtualization).

The system requirements are as follows:

Virtual Machines used for Repackaging (EXE/BAT/VBS/CMD)
Table 4: Requirements for Virtual Machine used for Repackaging

Running under 
Hypervisor

Operating System RAM 
(GB)

Minimum 
Display 
Resolution

Software

One of:

 l Microsoft 
Hyper-V

 l VMware 
Workstation 9
(with shared 
VMs)

 l VMware 
Server 
2.x/ESX 
Server 5.1

One of:

 l Windows XP SP3 
32-bit  (x86)

 l Windows 7 32-bit 
(x86)

NOTE: Windows 
Vista is not 
supported, even 
in its 32-bit 
version.

IMPORTANT: If 64-
bit Repackaging is 
required, then 
you can use the 
version of MSI 
Studio that is 
bundled with 
ChangeBASE, 
provided  that the 
repackaged 
applications 
undergo full 
testing prior to 
deployment, 
especially if they 
require COM 
(Component 
Object Model)
 servers.

4 or 
greater

1024 x 768 
pixel array

As follows:

 l Microsoft.NET Framework 
3.5 SP1 and:

 l .NET 4 or later (Full 
Version) for 
Windows 7

 l .NET 4.0.x (Full 
Version) for 
Windows XP

 l VMware Tools for a 
VMware-based VM.

 l Hyper-V Integration 
Services for a Microsoft 
Hyper-V-based VM.

 l CBVMTools (supplied 
with ChangeBASE).

ChangeBASE 6.2.3
Prerequisites and Getting Started Guide

12



Virtual Machines used for Virtualization
Table 5: Requirements for Virtual Machine used for Virtualization

Running under 
Hypervisor

Operating System RAM 
(GB)

Minimum 
Display 
Resolution

Software

One of:

 l Microsoft 
Hyper-V

 l VMware
Workstation 
9
(with shared 
VMs)

 l VMware 
Server 
2.x/ESX 
Server 5.1

One of:

 l Windows XP SP3 
32-bit  (x86)

 l Windows 7 32-bit 
(x86)

 l Windows 7 64-bit

 l Windows 8 32-bit 
(x86)

 l Windows 8 64-bit

 l Windows Server 
2003 R2

 l Windows Server 
2008 R2

 l Windows Server 
2012

NOTE: Windows 
Vista is not 
supported, even 
in its 32-bit 
version.

4 or 
greater

1024 x 768 
pixel array

As follows:

 l Microsoft.NET 
Framework 3.5 SP1 and:

 l .NET 4 or later (Full 
Version) for 
Windows 7 and 
Windows 8

 l .NET 4.0.x (Full 
Version) for 
Windows XP

 l VMware Tools for a 
VMware-based VM.

 l Hyper-V Integration 
Services for a Microsoft 
Hyper-V-based VM.

 l One or more of the 
following:

 l App-V Sequencer 
4.6 SP1/5.0 (also 
requires Windows 7 
SP1)

 l ThinApp Setup 
Capture 4.6.1

 l Symantec Wise 
Composer with 
Symantec 
Workspace 
Virtualization 
Admin (Client) 6.1

 l CBVMTools (supplied 
with ChangeBASE).

IMPORTANT:  

 l Do not disable Internet Protocol Version 4 (TCP/IPv4) on any of the Virtual Machines.

 l The VMware VIX library only allows connections to one type of provider per process. This means that you 
can only configure ChangeBASE to use either Workstation- or Server-based Virtual Machines, not both.
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 l If you are running ChangeBASE on a Machine that does not have VMware Workstation installed and you 
want to connect to an ESX/vCenter server, or if you encounter errors connecting to ESX servers 5.1 and 
above, download and install the VIX SDK (http://www.vmware.com/support/developer/vix-api/).

 l The  App-V 5.0 Sequencer requires the prior installation of Microsoft.NET Framework 4.0 Full and 
PowerShell 3.0. The latter is automatically installed with Windows 8 and Windows Server 2012. 
Alternatively, you can download it from http://www.microsoft.com/en-
gb/download/details.aspx?id=34595 or http://www.microsoft.com/en-
us/download/details.aspx?id=34595.

Recommended Configuration for Optimal 
Performance
For optimal performance it is recommended that:

 l If you are using VMware Workstation (with shared VMs), you use 64-bit Windows for the host machine.

 l If you are using 64-bit Windows for the SQL Server machine, you use 64-bit SQL Server.

Space requirements for the database are 16 GB per 400 packages (40 GB per 1000).

NOTE: When large numbers (more than 2000) of packages are imported into ChangeBASE, you may 
experience a degradation of import speeds. Over the course of time, the indexes on some tables can 
become fragmented which has a negative impact on performance. In this situation, please refer to the 
Dell Knowledge Base article 135255 for more details.

Best Practice Setup using Active Directory
The following procedure is recommended if your site uses a client/server environment and is able to take 
advantage of the Active Directory (AD) service included in most Windows Server Operating Systems.
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Figure 2: Client/server set up

To set up using Active Directory

 1. Assuming that SQL Server has already been installed centrally, create an AD group related to 
ChangeBASE.

 2. Create a user account (for example SVC_ChangeBASE) that will be used to connect to the ChangeBASE 
service, and ensure that the password is set to never expire.

NOTE: This account will be prompted for when you select the ChangeBASE service during installation.

You will associate the account with the SQL Server dbcreator and sysadmin roles via the Login 
Properties of the AD group at the step starting Set up SQL Security as follows:

 3. Ensure that this SVC_ChangeBASE account has the Log on as a Service Right so that it can access the 
ChangeBASE service.

 a. To add the Log On as a Service Right to the account if it is on your local computer:

 i. Select Control Panel > Administrative Tools > Local Security Policy.

 ii. In the console tree, double-click Local Policies, and then click User Rights Assignment.

 iii. In the details pane, double-click Log On as a Service.

 iv. Click Add User or Group, and then add the account to the list of accounts that possess 
the Log On as a Service Right.
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 b. To add the Log On as a Service Right to the account if it is not on your local computer:

 i. Select Start > Run, type mmc, and then click OK.

 ii. Select File > Add/Remove Snap-in.

 iii. In Add/Remove Snap-in, click Add, and then, in Add Standalone Snap-in, double-click 
Group Policy Object Editor.

 iv. In Group Policy Object, click Browse, move to the GPO (Group Policy Object) that you 
want to modify, click OK, and then click Finish.

 v. Click Close, and then click OK.

 vi. In the console tree, click User Rights Assignment.

 vii. In the details pane, double-click Log On as a Service.

 viii. If the security setting has not yet been defined, select the Define these policy 
settings check box.

 ix. Click Add User or Group, and then add the account to the list of accounts that possess 
the Log on as a Service Right.

 4. Add this service account to the ChangeBASE AD group.

 5. Add the machine account of the server hosting IIS (Internet Information Services) to the ChangeBASE AD 
group. This server will be used for ChangeBASE Web reporting.

 6. Set up a central reports directory that can be accessed by the IIS server, for example My Reports.

 7. To set up the virtual reports directory on the server hosting IIS:

 a. Open IIS.

 b. Right-click on Sites and then Add Web Site.

 c. Give your Site a name and set the Physical Path to the virtual directory that you created above.  
Leave all other settings as default.

NOTE: If you receive a warning about port binding you should increment the Port until the 
warning ceases.

 d. Right-click on your Website and select Properties.

 e. Share the virtual directory to allow ChangeBASE to export your reports. To do this, go to Sharing 
and click Share.

NOTE: If you have specific report authors, then you can explicitly share with them, but, as a 
minimum, you will need to add the account that will be used to connect to the  ChangeBASE 
service. If this account is already in a ChangeBASE Active Directory group, simply add this group 
in place of Everyone in the above example.

 f. Click on your Website, followed by Directory Browsing.
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 g. Click on Enable.

NOTE:  The final step will be to link the Physical Path (D:\My Reports) to ChangeBASE. This will be 
done at the end of this Best Practice Setup, as the last part of the product setup.

 8. Open SQL Server Management Studio and connect to the SQL Server instance. 

TIP:  If you want to know the name of the SQL Server instance, open the Services window and select SQL 
Server. The instance name is given in brackets.

 9. Set up SQL Security as follows:

 a. Browse to Security > Logins.

 b. Right-click Logins and select New Login.

 c. Use Search to find the ChangeBASE group you created.

 d. Once you have located the group, click OK.

 e. Select Server Roles.

 f. Check dbcreator and sysadmin.

 g. Click OK.

 10. Install ChangeBASE on the central server that is to run the ChangeBASE service. Install both the service 
and client features.

 11. Apply permissions to C:\ProgramData\ChangeBASE, as follows:

 a. Open Windows Explorer.

 b. Type C:\ProgramData\ChangeBASE into the address bar and press Return.

 c. Select the Security Properties and click Edit.
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 d. Click Add and add the ChangeBASE group.

 e. Check Allow next to Modify to give the group Modify permissions on the folder.

 f. Click OK.

 12. Set up shares and permissions to each of the Package Sources that you are going to set up in  
ChangeBASE, as follows:

 a. Locate the Package Source.

 b. Right-click on it and select Properties.

 c. Move to the Sharing tab and select Advanced Sharing.

 d. Check Share this folder.

 e. Click Permissions.

 f. Add the  ChangeBASE group to the share permissions.

 g. Check Allow next to Change.

 h. Click OK to return to the Sharing tab.

 i. Note the Network path.

 j. Select the Security tab and click Edit.

 k. Click Add and add the ChangeBASE group.

 l. Check Allow next to Modify to give the group modify permissions on the folder.

 m. Click OK. This may take some time to apply.

 n. Repeat the process for the next package source or select to run ChangeBASE.

Pre-Installation Steps
 1. Ensure that you have met all the system requirements.

 2. ChangeBASE will verify that the user account under which you log onto the SQL Server instance is 
associated with the SQL Server dbcreator and sysadmin  roles, so you need to ensure that the account is 
associated with these roles before starting to set up ChangeBASE.
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If you are going to use Windows Authentication, then  you can associate the logon with the dbcreator and 
sysadmin  roles via Server Roles in the SQL Server Login Properties. If you followed the Best Practice 
Setup using Active Directory, then you will have associated this account with the necessary rights via 
the ChangeBASE AD Group. Refer to Set up SQL Security.

 3. Ensure that the necessary shares have been created to the folder(s) containing the packages to be 
imported (refer to Best Practice Setup using Active Directory). 

 4. If you are running SQL Server and ChangeBASE on separate machines, check the following:

 l The SQL Server Browser service must be running, and set to Automatic on the machine where 
SQL is installed. 

 l Both the SQL Browser service and SQL Server must be allowed through your firewall.

 l The TCP/IP protocol must be enabled.

NOTE: Both "SQL Server Browser" and "TCP/IP" can be configured in SQL Server Configuration Manager:
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 5. If you are going to be importing Web data for assessment, having specified a browser platform, and wish 
to first capture the data using the Web Capture utility, then install and use it in accordance with the 
section on Web Capture.

 6. Ensure that you have your Site's Dell License Key and Site Message.
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3

Installing ChangeBASE

This chapter covers the following topics:

Local Installation

Multi-User Installation

Further Details on ChangeBASE

Local Installation
If you are installing all ChangeBASE components on the same machine, proceed as follows.

To install ChangeBASE

 1. Run the ChangeBASE installation MSI (Local Administrative privileges are required), and click Next. 

 2. Accept the license agreement and click Next.

 3. Ensure that both the ChangeBASE Client and ChangeBASE Service are set to Will be installed on local 
hard drive, and, if required, install MSI Studio locally under the ChangeBASE Client option.

If required, change the location of the installation as required, using the Browse button. 
Then click Next.

 4. Specify how you will be logging onto the ChangeBASE service and ener the service account credentials.

For a local installation, leave Run service as LocalSystem selected.
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CAUTION: There is no facility within ChangeBASE to modify access to the service once setup is 
complete. For example, if the service is started in LocalSystem, then all the files created in 
ProgramData will be owned by LocalSystem, and all the individual file permissions would need to 
be changed if access to the ChangeBASE service was subsequently modified to run under a network 
account.

 5. Click Next, and then Install. 

 6. Once installation is complete, click Finish. 

Multi-User Installation

ChangeBASE Service Installation

To install the service

 1. On the server where  ChangeBASE service is to be hosted, run the he ChangeBASE installation MSI (Local 
Administrative privileges are required), and click Next. 

 2. Accept the license agreement and click Next.

 3. Right-click the ChangeBASE Service to ensure it is set to Will be installed on local hard drive.

If required, change the location of the installation as required, using the Browse button.  
Then click Next.

 4. Specify how you will be logging onto the ChangeBASE service and enter the service account credentials.

You can leave Run service as LocalSystem selected if you are installing all ChangeBASE components on 
the same machine. Otherwise, select Run service as: and enter the user Account and Password for the 
particular account that you created for accessing the service.  Refer to Create a special user account 
that will be used to connect to the ChangeBASE service, and ensure that the password is set to 
never expire.

IMPORTANT: The account that you specify must have the   Log on as a Service Right. Refer to Ensure that 
this SVC_ChangeBASE account has the Log on as a Service Right so that it can access the 
ChangeBASE service. Therefore, if the account that you specify does not have this Right, an appropriate 
warning will be displayed when you click Test Credentials in the above dialog.

CAUTION: There is no facility within ChangeBASE to modify access to the service once setup is 
complete. For example, if the service is started under one account, then all the files created in 
ProgramData will be owned by that account, and all the individual file permissions would need to 
be changed if access to the ChangeBASE service was subsequently modified to run under a 
different account.

 5. Click Next, and then Install. 

 6. Once installation is complete, click Finish.

Client Installation
After installing the ChangeBASE service, proceed as follows for each client.
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To install the client

 1. Run the ChangeBASE installation MSI (Local Administrative privileges are required), and click Next. 

 2. Accept the license agreement and click Next.

 3. Leave the ChangeBASE Client at the default Will be installed on local hard drive, and, if required, 
install MSI Studio locally under the ChangeBASE Client option. Right-click the ChangeBASE Service, 
and select Entire feature will be unavailable.

Then  change the location of the installation as required, using the Browse button.

 4. Click Next, and then Install. 

 5. Once installation is complete, click Finish. 

Further Details on ChangeBASE
For information on the configuration and use of ChangeBASE, select Dell > ChangeBASE > ChangeBASE User 
Guide from the Windows Start menu, to view the user guide in PDF format. Alternatively, select the Help tab 
from the product About box to view the online version.
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4

Web Capture

This chapter covers the installation of the Web Capture utility.

Web Capture Installation
You can install the Web Capture utility on a ChangeBASE client, the ChangeBASE server, or on its own 
dedicated server.  

NOTE:  If you are going to be installing the utility on its own dedicated server, then the requirements for 
this machine are the same as for Minimum Client Requirements.

To install ChangeBASEWeb Capture

 1. Run the  installation MSI - ChangeBASE_Web_Capture.msi - and click Next. Local Administrative 
privileges are required.

 2. Accept the license agreement and click Next.

 3. Change the location of the installation as required, using the Browse button, before clicking Next.

 4. Click Next, and then Install. 

 5. Once installation is complete, click Finish. 

Further Details on Web Capture
For information on the configuration and use of this utility, select Dell > ChangeBASE > ChangeBASE User 
Guide from the Windows Start menu, to view the user guide in PDF format, and go the last chapter. 
Alternatively, select the Help tab from the product About box to view the online version, and click on Web 
Capture in the Contents pane.
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About Dell

Dell listens to customers and delivers worldwide innovative technology, business solutions and services they 
trust and value. For more information, visit www.software.dell.com.

Contacting Dell
Technical Support: 
Online Support

Product Questions and Sales: 
(800) 306-9329

Email: 
info@software.dell.com

Technical support resources
Technical support is available to customers who have purchased Dell software with a valid maintenance 
contract and to customers who have trial versions.  To access the Support Portal, go to 
http://software.dell.com/support/.

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours 
a day, 365 days a year. In addition, the portal provides direct access to product support engineers through an 
online Service Request system.

The site enables you to:

 l Create, update, and manage Service Requests (cases)

 l View Knowledge Base articles

 l Obtain product notifications

 l Download software. For trial software, go to Trial Downloads.

 l View how-to videos

 l Engage in community discussions

 l Chat with a support engineer
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